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Module 15

Sweetening Your Sound

Adobe® Premiere® Pro's audio effects "sweeten" your sound. They can dramatically change the feel of your
students’ projects. As with video effects, you set the parameters of audio effects from within the Effect Controls
window. Some are specialized effects from a family of audio plug-ins using VST—Virtual Studio Technology—a
new feature of Adobe Premiere Pro.

Adobe Premiere Pro’s audio mixer is a leap forward in controlling audio for projects. Combined with Adobe
Premiere Pro’s new submix track option, track-level audio effects, and live narration recording, they bring a lot of
flexibility to your students’ audio management.

At the end of this lesson, students will have learned about:

• Sweetening sound—Adobe Premiere Pro’s audio effects

• Revealing the power of VST plug-ins

• Delving into Adobe Premiere Pro’s new audio tracks

• Working with the new audio mixer

Sweetening Sound—Adobe Premiere Pro’s Audio Effects

Adobe has updated Adobe Premiere Pro’s suite of audio effects. Most of the new effects arrive courtesy of VST
software that fosters the integration of audio effect processors with PCs. In the case of Adobe Premiere Pro, it
opens the door to a world of third party audio effect plug-ins; little mini-programs that show up in the Audio
Effects palette. You can add dozens of VST audio effects to that collection. I cover VST in the next section,
“Revealing the Power of VST Plug-ins.”

Previous versions of Adobe Premiere placed the audio effects into seven categories. Now, you access them
alphabetically. Unless you’re an audio engineer, some of their names—Bandpass, MultibandCompressor, and
Parametric EQ, for instance—might be a bit obtuse.

I take you through some of them to give you a taste of what to expect. For more information on what each effect
does, take a look at the Adobe Premiere Pro online help section. Under Contents, select Applying Effects, and
then select Audio Effects Included With Adobe Premiere Pro.

Ultimately, the best way to learn more about these effects is to try them out. They are nondestructive. That is,
you can use them on any clip without changing the original clip’s audio quality.
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Task: Working with Audio Effects
Before I explain the audio effects function, I want to give you a
brief overview of how to work with them. You’ll start with a
couple straightforward effects and then take a look at some of
the higher-level tools. Here’s how to add audio effects to clips:

1. Open Adobe Premiere Pro to either your customized
audio workspace or the default workspace by
selecting Window > Workspace > Audio—or—Your
Audio Workspace.

2. Clear everything off your sequence and place a short
(no more than 30 seconds) audio or linked
audio/video clip by itself on the Audio 1 track. The
reason for the short clip duration is your audio
playback convenience.

3. Open the Effects tab (its default location is in the
Project window). Twirl down the Audio Effects
disclosure triangle to reveal three sub-folders: 5.1,
Stereo, and Mono (with only a couple exceptions,
such as Balance, all three have the same set of audio
effects). Twirl down the Stereo disclosure triangle to
reveal its 24 effects. Figure 15.1 shows how that
should look.

4. Drag and drop the Balance effect on your audio clip.
Select that clip to display it in the Effects Control
window (ECW). Twirl down the two disclosure
triangles to reveal the two keyframable parameters
shown in Figure 15.2: Bypass and Balance.

FIGURE 15.1: Adobe Premiere Pro's full set of 24
stereo audio effects.
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FIGURE 15.2: How the simplest of Adobe
Premiere Pro’s audio effects looks

Tip: What’s Bypass?

All audio effects (including the fixed
Volume effect) have a Bypass parameter.
Basically, checking Bypass means Adobe
Premiere Pro will ignore this effect and
play the clip as if the effect had not been
applied to it. What makes this an important
feature of each audio effect, is that Bypass
is keyframable—you can set the exact
moments when it switches off an effect
and switches it back on.

5. Using keyframes, set the balance
completely to the left (-100%) at the start of your clip and then move it to the right (+100%) at the end.
Play the clip. The audio should move from left to right.

Tip: Use Keyframes Liberally

Consider how you could use keyframes. The obvious usage is to change an effect over time. But consider
those obnoxious ads in which the narrator suddenly has a booming, echoing voice. You, too, can duplicate
those spots. Simply select Reverb and set keyframes for the beginning and end of that booming delivery.

6. Add two Bypass keyframes somewhere
toward the middle of your clip. The first
should have the Bypass box checked, but
the second should be unchecked. Play the
clip. The sound should begin to move from
the left to the right, jump to the center,
jump toward the right, and finish its move
to the right channel. Bypass tells Adobe
Premiere Pro to ignore any effect settings.

7. Remove the Balance effect (or click its little
f to turn it off) and drag Delay, a slightly
more complex audio effect, to the ECW.
Twirl down its disclosure triangles to reveal
three parameters (shown in Figure 15.3):
Delay, Feedback, and Mix. Delay creates
distinct echoes as opposed to Reverb,
which creates more of a collection of
echoes that you’d experience in a closed
room.

FIGURE 15.3: Delay—or echo—has slightly more
complexity than Balance.
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Tip: Delay Equals Echo

The Delay parameter specifies the amount of time before the echo plays. Increasing the Feedback setting
means you get echoes of echoes. And the Mix setting determines the prominence or subtlety of the echo.

Take a look at the Multitap Delay. This creates up to four distinct sets of delays or echoes using the same
parameters as the Delay effect.

8. Remove the Delay effect, drag Parametric EQ to the ECW, and twirl down its disclosure triangles. As
shown in Figure 15.4, this effect boosts or decreases the gain of a selected frequency region. If you want
to boost the bass, move the Center slider to the left (lower frequencies), and increase the Boost. Cut the
bass by moving the Boost slider to the left. Increase the width of the selected frequencies using the Q
slider.

Tip: Multiple Uses of the Same Effect

You’ve probably seen an equalizer. Many
car and home stereos have them. They
enable you punch up multiple, pre-set
frequency ranges. Many enthusiasts use
them to boost the heck out of the bass and
rattle windshields and nerves of passing
motorists.

Parametric EQ lets you select only one
frequency range. But you can use
Parametric EQ multiple times and select
multiple frequencies. In effect, you can
build a full graphic equalizer within the
ECW. Or you can use Adobe Premiere Pro’s
EQ effect and its built-in five frequency
ranges.

FIGURE 15.4: Parametric EQ lets you boost or
decrease the gain for a user-set frequency range
at a user-designated frequency.

Revealing the Power of VST Plug-ins

Take a look at one more audio effect. This one is guaranteed to make your head spin. Delete Parametric EQ and
drag MultibandCompressor to the ECW. As Figure 15.5 shows, you'll need to dramatically expand the ECW to see
only some of the parameters.

It works best if you drag the tab out of the Monitor window to create a separate Effect Controls window. Then
drag the right edge of the parameter view by placing the cursor over the thin line until it turns into the double-
arrow cursor circled in Figure 15.5.
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FIGURE 15.5: The MultibandCompressor audio effect is one of several VST plug-ins. Its primary use is to reduce a clip’s
dynamic range. That is, decrease the gain for loud sounds and increase it for soft sounds.

Tip: Close the ECW Timeline to Free Up
Space

To add a little screen real estate to the ECW, close its mini-timeline display. Do that by clicking the chevron
indicated by an arrow in Figure 15.4. Re-open it using the same chevron button.
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This sudden appearance of a rack of control knobs signals your first look at a VST plug-in. These are custom-
designed audio effects that adhere to a standard set by Steinberg audio. Invariably, those who create VST audio
effect plug-ins want them to have a unique look and offer some very specialized audio effects.

Note: Charlie Steinberg—Audio Visionary

To learn more about VST, I suggest you read an interview with Charlie Steinberg, the man behind VST and
other audio innovations. You can start at   http://www.steinberg.net .

The MultibandCompressor’s purpose is to narrow the dynamic range for up to three sets of frequency ranges. It
works like the Dynamics effect but can create a softer sound.

Explaining its parameters could take a full module. Instead, note that it offers a collection of pre-sets. Adobe
Premiere Pro alerts you to the presence of that collection by adding a tiny triangle below the reset button. I’ve
put a box around it in Figure 15.5.

While the audio is playing, experiment with the MultibandCompressor by grabbing the diamond-shaped
handles in the display screen and dragging the three boxes up or down or their vertices left or right. Finally, take
a look at the mind-boggling array of additional individual parameters below the knobs. One real important
reason to break them out individually is to let you set keyframes for any of them.

Other VST Effects

Take the Adobe Premiere Pro’s other VST audio effects for brief spins:

• DeNoiser—Automatically detects and removes tape noise

• Dynamics—Compresses dynamic range

• EQ—A multiple-band parametric EQ

• Pitch Shifter—Raises or lowers pitch

• Reverb—Simulates various room sounds

• DeEsser -- Remove sibilance and other high frequency "SSS"-type sounds, which are often created when
a narrator or vocalist pronounces the letters "s" and "t."

• DeHummer -- Removes unwanted 50 Hz/60 Hz hum from the audio caused by poorly shielded cables,
grounding loops, and dimmer. Select 50 or 60 Hz depending on your location: 50 Hz for Europe and
Japan, 60 for the U.S. and Canada.

Tip: Some EQ Uses

You can use EQ to give oomph to a thin vocal by rolling off the high frequencies and boosting the bass.

If you have isolated recordings of instruments in a band, you can add presence to each one by boosting
portions of their frequency range. Giving them a little more treble increases their "attack." If you have
trouble with audio hum or "popped P's," reducing the low frequencies might help. You can use EQ to "carve
out" a vocalist's range within an instrumental, giving that singer more "visibility."



Adobe Digital Video Curriculum Guide – Module 15 15-7

Adobe Digital Video CURRICULUM GUIDE

There is a treasure trove of VST plug-ins available on the Internet. I suggest you start your quest at
http://www.kvr-vst.com/  . Check out Quick Effect Links for a lengthy listing of VST audio effects, all of which
should work with Adobe Premiere Pro.

There's no need to check out K-V-R’s Quick Instrument Links because Adobe Premiere Pro does not support
instruments.

Most of these VST audio effect plug-ins cost something, but there are a few freebies. In particular, check out
Little Duck. Figure 15.6 shows how it appears in Adobe Premiere Pro. It emulates a classic analog filter bank.

Little Duck’s developer, Land of Cockaigne, offers several other free VST plug-ins featuring an older analog look
at its Web site:    http://www.funkelectric.com/~cockaigne/ .

FIGURE 15.6: The Little Duck VST plug-in audio effect offers five analog-like filters as well as other controls.

Adding Multiple Audio Effects to a Clip

You can add multiple audio (and video) effects to the same clip. For instance, you might have a video with a bass
player on the left and a guitar on the right. You could use Balance to start on the left and use Bass to emphasize
that instrument. Then as you move the balance to the right using keyframes, you could reduce Bass and bring in
Treble.

Note: Combine Effects for Surprising Results

For a little fun, add both a Highpass and Lowpass filter to a clip. These effects pass through high or low
frequencies and cut off the rest. Set each high and low cutoff frequency to the same value. The result should
be near or complete silence.

Delving Into Adobe Premiere Pro’s New Audio Tracks

Adobe Premiere Pro's new audio tracks open up extra editing opportunities. There are now three track types:
clip, submix, and master. As you work with Adobe Premiere Pro, you'll begin to see the value of these additional
tracks.
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Basically, your original clips go into clip tracks. You then can send them directly to the final master track (that’s
the default action) or send some or all of them to submix track(s). You can set volume levels and apply effects to
the clips individually, to entire clip tracks, and to entire submix tracks and to the master track itself. Anything you
do to a clip or clip track changes how it sounds in the submix and master tracks. Anything you do to a submix
track changes how the master track sounds. To give you an idea of how this might work in real-world
productions, here are two scenarios as suggested by the Adobe Premiere Pro development team:

• A two-camera shoot with additional narration and background music. You have two tracks of audio
(one from each camera) and a narration, and then you have two tracks of music. You would like to be
able to control the overall balance of voice and music. To do that, add two submix tracks. Assign all the
voice tracks to one track and all the music tracks to the other. Now you can use the Volume effect in the
voice submix track to control all the voice levels together and the Volume effect in the music submix
track to control all the music together. This is called stemming. You still can adjust the relative levels of
the clips within their own voice and music clip tracks.

•  You want to add reverb to two tracks of vocals. To make this sound right, you want to use the same
reverb parameters for both tracks. Add a submix track and add the reverb filter to that track. Assign
each of the voice tracks to the submix track. Now you have what is known as a dry (original) signal in
each clip track and a wet (edited) signal on the submix. You can control the amount of voice going to
the reverb by changing the volume on the original clip track(s).

Adding and Sending Audio Tracks

You’ve noted that if you drag a clip to an empty space in a sequence, Adobe Premiere Pro automatically creates
a new audio track that matches the type of audio: mono, stereo, or 5.1.

Task: Creating a Submix Track
If you want to add a submix track, you need to take a less automated route. You can use the same process to add
any other type of track. Here’s how you create a submix and send—or assign—an audio track to it:

1. As shown in Figure 15.7, right-click on an empty area on the left side (where the track names are) of a
sequence and select Add Tracks.

FIGURE 15.7: Use the sequence's context (right-click) menu to select Add Tracks.
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2. In the Add Tracks dialog box shown in Figure 15.8, set Add Video Track(s) and Add Audio Track(s) to 0,
set Audio Submix Tracks to 1, select a placement and track type, and click OK.

FIGURE 15.8: Use the Add Tracks dialog box to add an audio submix (or other video and audio tracks.

3. Take a look at the bottom of the audio mixer. As highlighted in Figure 15.9, Audio 1 (and any other clip
tracks you have in your sequence) now has the option to send its signal to Submix 1. If you select
Submix 1, whatever audio is on Audio 1 will also go to Submix 1. If you send several clip tracks to
Submix 1, Adobe Premiere Pro combines them using whatever audio gain levels and effects you set in
their original clip tracks.
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FIGURE 15.9: The drop-down list at the bottom of the audio
mixer now enables you to send an audio clip track to a
submix track.

Working with the New Audio Mixer

Adobe Premiere Pro’s new audio mixer is a giant step up
from previous versions. It is the focal point of your audio
production. In previous versions of Adobe Premiere its
primary task was to enable you to manually control audio
levels (recording your actions as you applied them). This
updated version improves on that functionality as and
offers two big improvements: the capability to apply
effects to entire tracks and a means to record a narration
directly to a sequence.

Task: Recording a Narration and
Adding Track Effects
I won't go into too many details because the Adobe
manual explains things well. However, I do suggest
experimenting with the audio mixer:

1. If you haven't already done so, expand the Audio
Mixer view by clicking the disclosure triangle
circled in Figure 15.10.

2. To record a narration, make sure that your PC mic
is plugged in to the Mic input on your sound card and  turned on. To do that, open the Control Panel,
and double-click Sounds and Audio. In the Volume tab, click Advanced and check to see that
Microphone is not muted.

3. Activate the Adobe Premiere Pro narration record mode by clicking the Microphone button in one of
the audio clip tracks (you can’t record a narration to the master or submix tracks).

4. Click the red Record button at the bottom of the audio mixer. It’ll start blinking. You can move the CTI
edit line to where you want this narration to begin (it'll cover up any audio at that location) and then
click the Play button to start recording. When you finish recording, click the Stop button and note that
an audio clip appears on the selected audio track.
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FIGURE 15.10: Open the Audio Mixer to display all its
features by clicking the circled disclosure triangle.

Note: Watch Your Levels

Watch your voice levels in the mixer’s audio track VU
meter—the two parallel, vertical bars next to the
volume slider. You want to avoid too much volume
(indicated by a red display in the VU meters) or too
little. Occasionally jumping into the yellow zone
toward the top is fine.

Note: What to Do About Feedback

If you record audio and you have taken no steps to
mute the output, you might get feedback—that lovely
screeching noise that happens when a mic gets too
close to a loud speaker. There are several remedies:

• Use the Mute button on the track in the sequence

• Drop the master fader bar to -∝

• Change the assign for the track to a submix track
and drop that Submix track fader bar to -∝

• Turn down your speakers (you can use
headphones to hear yourself)

5. You use the Audio Mixer to add audio effects to
the entire track by clicking the drop-down list
triangle highlighted in Figure 15.11 and selecting
from that list (it has all but a few of the clip-based
effects).

6. Each effect offers some level of control at the
bottom of the audio mixer’s mini-window. Some
effects, such as Reverb shown in Figure 15.11,
have drop-down lists of pre-sets.
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FIGURE 15.11: Add a track effect by clicking the triangle to reveal a
drop-down list. Make adjustments using controls that display in the
Mixer mini-window.

Note: Effects Apply to Entire Track

These effects do not have the detailed control that you find
when applying them to clips. Nor can you use keyframes.
These effects apply to entire tracks. That's the beauty of
track-based effects: their uniformity over an entire track.

Changing Track Gain and Balance or Pan

Adobe Premiere Pro’s online help file has a thorough
explanation of the audio mixer. Select Help > Contents > Mixing
Audio to open that lengthy and detailed section.

Essentially, the audio mixer makes it possible for you to adjust
audio gain and balance (or pan for mono tracks) on the fly,
recording your changes as you make them. If you don’t like the
mix, you can make adjustments using the mixer or, as shown in
Figure 15.12, by dragging the Track Volume handles in the audio
track waveform display. To display those keyframes, click the
Show Keyframes button and select Show Track Volume.
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FIGURE 15.12: After using the audio mixer to set volume or gain levels for an entire track, you can move the volume
handles in that track’s waveform in the Timeline Window to adjust those levels.

You make your audio gain and left/right balance changes after selecting an automation
setting from the drop-down list (shown in Figure 15.13) at the top of the selected track.
You have five automation setting choices:

FIGURE 15.13: Adobe Premiere Pro offers five automation controls in the audio mixer. Latch,
Touch, and Write each gives you slightly different levels of control over how you change a
track’s volume.

• Off—Ignores any existing playback settings so that you can preview any changes as you make them
without reverting to previous settings and without recording those changes.

• Read—Plays back any automation changes you’ve made.

• Write—Records adjustments as you make them and creates keyframe handles that display in the
sequence’s track waveform.

• Latch—Same as the Write setting except that nothing changes until you adjust a value; that value then
holds until you change it.
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• Touch—Same as the Latch setting except if you release the gain fader, the value returns to its previous
setting.

Automation Keyframe Optimization

Automating audio changes in the Audio Mixer typically creates many more keyframes in the audio track than
necessary. That can cause a degradation in performance and make it difficult to edit individual keyframes
because they are so densely packed.

Premiere Pro 1.5 has a new feature
that fixes that minor irritation
Automation Keyframe Optimization.

To set the Automation Keyframe
Optimization preference, choose
Edit > Preferences > Audio.

As shown in Figure 15.14, in the
Automation Keyframe Optimizations
area, select one or both of the
following options, and then click OK:

FIGURE 15.14: New to Premiere Pro
1.5 is a means to avoid overloading
your audio clip with keyframes when
automating audio changes in the
Audio Mixer.

Linear Keyframe Thinning -- Creates keyframes only at points that do not have a linear relationship to the start
and end keyframes. For example, suppose you are automating a fade from 0 dB to -12 dB. With this option
selected, Adobe Premiere Pro only creates keyframes at the points that represent an increase in value from the
beginning (0 dB) and ending (-12 dB) keyframes. If you do not select this option, Adobe Premiere Pro may create
several incremental keyframes of identical values between those two points, depending on the speed at which
you change the value. This option is selected by default.

Minimal Time Interval Thinning -- Creates keyframes only at intervals larger than the value that you specify. Enter
a value between 1 and 30 milliseconds.

Surround Sound Panning

As far as automation is concerned, the surround panner works just like the stereo panner. As shown in Figure
15.13, if you create a 5.1 project, the audio mixer master track will have six VU meters and each clip track (mono,
stereo, or 5.1) will have a panner setting display window.
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To manually set panning for a track, set Automation to one of the Write
modes, play your audio track, and grab and drag the little dot
(highlighted with an arrow in Figure 15.15) to move the audio around the
5.1 surround location.

FIGURE 15.15: When working with 5.1 clips or projects, Adobe Premiere Pro
enables you to manually adjust surround sound panner settings by dragging
the little dot around inside this little window.

As you set these new locations, they show up as keyframe handles in your
sequence. To view them and manually change them, click the Show
Keyframes button and select Show Track Keyframes.

It would be impractical to show all keyframes for all six surround sound
locations. Adobe Premiere Pro makes it possible for you narrow down
your view in the clip’s waveform display. As shown in Figure 15.16, use
the clip’s drop-down list and select Panner > Left-Right, Front-Rear,
Center or LFE (low-frequency effects that are routed to the sub-woofer) to
display the keyframe handles you created in the mixer.

FIGURE 15.16: 5.1 panner adjustments done in the audio mixer show up as keyframe handles in the audio track.

You can use the Pen tool (it offers more precise control than the Selection arrow and enables you to add
keyframes) from the Tools palette to add, delete, or adjust these handles:
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• Add a keyframe by holding Ctrl and clicking on the yellow panning line.

• Move keyframes by grabbing and dragging them.

• Use the Pen tool (select it from the Tools palette or use its keyboard shortcut: ‘P’) to drag bounding
boxes around groups of keyframes, and then hold down Shift, grab one of the highlighted keyframes,
and drag the collection en masse to a new location.

• Delete a keyframe by selecting it with the Pen tool and pressing Delete. Delete a group by dragging a
bounding box around them and pressing Delete.

Note: Panner Seems Jerky—Not to Worry

The surround panner definitely tracks smoothly between points. If your PC is slower than most, you might
see some jumpiness on the display updates in the mixer window, but the internals will track smoothly.
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Adding effects to clips on an Adobe Premiere Pro sequence can bring a project to life. The Effect Controls
window tracks each clip's effects, gives you detailed control over their individual features, and offers keyframes
for those attributes. The addition of VST plug-in support means Adobe was able to include some very powerful
and detailed effects.

The new audio mixer and audio tracks open up all sorts of extra control possibilities for Adobe Premiere Pro. It’s a
simple matter to apply effects to entire tracks and adjust volume and balance/panning changes on the fly.

Q. I worked in the audio mixer for a while and then returned to the Timeline window. When I play my
video, I don’t hear anything, but I didn't mute the audio track. What’s going on?

A. You probably muted the track in the audio mixer. Unfortunately, that action does not make itself apparent in
the sequence display. Go back to the audio mixer and unselect the Mute button for your track. The button is
right above the volume fader bar.

Q. I want to get a nice distinct echo effect, but Reverb sounds like a lot of echoes instead of only one. Is
there a way to get only one echo, or at least some limited number of echoes?

A. Yes. Use Delay. It creates an exact duplication of whatever is on your audio clip. That can be very
disconcerting if it’s music—you’ll hear every guitar strum twice, for instance. But if you have a voice shouting out
a word or phrase, you can adjust the settings to have that echo come back quickly or with a delay of up to 2
seconds and have it blend with the original clip or not.

Quiz

1. You need to boost treble and bass. You have several possibilities. What are they?

2. There are at least three ways to make audio move from the right channel to the left and back. What are
they?

3. You recorded a speech, but the presenter is too quiet and the waiter's clattering trays are too jarring. How
can you fix those problems?
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Quiz Answers

1. Take your pick. The easiest but least precise method is to add treble and bass to the clip. Using the
Parametric EQ effect twice to boost each end of the audio frequency spectrum gives you a fine level of
control. Or try EQ, turn off the midrange frequency bands, and adjust the low and high ends.

2. Use one of two effects: Balance adjusts the overall balance, left or right, and Channel Volume enables you to
adjust the volume of each channel individually. If you drop the left to -∝ and the right to full 6dB, you’ve
accomplished virtually the same effect, but the clip will sound louder. To get audio to switch back and forth,
use keyframes. Or use the Audio Mixer’s Left/Right Balance control knob.

3. You want to minimize the clattering trays by reducing the high end of the volume when the clattering
happens and remove it when the speaker pauses. Also, you want to increase the low-volume portions to
better hear the speaker. Use Dynamics to do both. Use its Gate feature to cut off the signal when the speaker
pauses, use Compressor to bring up the soft speaker levels, and use Limiter to cut off any loud sounds.

Exercises

1. Experiment with the Multitap Delay audio effect. Use it on a solo instrument, a solo voice (record your own,
perhaps), and music with a hard beat. This is a slick and exciting toy that can give some real presence to
audio.

2. Create a chorus using a voice. Use your camcorder or PC mic to record yourself (or a volunteer) singing a
song. Add it to a sequence. Then use the PitchShifter audio effect on it. Add several audio tracks. Place the
CTI edit line at the beginning of the original clip, copy the clip (right-click > Copy), select an empty track by
clicking the track name, and then select Edit > Paste (or Ctrl+V) to place that copy on the sequence. Do that
several times. Select each clip in turn and slightly adjust the PitchShifter’s Fine setting. It takes some trial and
error to avoid a warbling sound, but if all goes well, you’ll turn a soloist into an ensemble.

3. Create a full-featured graphics equalizer by layering several Parametric EQ effects on the same clip. You can
use EQ’s five frequency presets, but using multiple instances of Parametric EQ is a good way to precisely
control some very specific frequencies ranges. Preview your work as you make changes. After you've created
a collection in the ECW, turn one or more of the effects off (click the ‘f’ check box) and then listen to the
difference.

For complete information about Adobe digital video tools, please visit the Adobe Education Web site: www.adobe.com/education
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